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About this manual1.

Copyrights1.1.

The information in this document is subject to change without notice and should not be
construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for any
errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or consequential
damages of any nature or kind arising from the use of this document, nor shall ABB Oy
be liable for incidental or consequential damages arising from use of any software or
hardware described in this document.

This document and parts thereof must not be reproduced or copied without written per-
mission from ABB Oy, and the contents thereof must not be imparted to a third party
nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and
may be used, copied, or disclosed only in accordance with the terms of such license.

© Copyright 2006 ABB. All rights reserved.

Trademarks1.2.

ABB is a registered trademark of ABB Group. All other brand or product names men-
tioned in this document may be trademarks or registered trademarks of their respective
holders.

General1.3.

This manual provides thorough information on the COM600 HMI and the central concepts
related to it. For more information on each topic related to a specific protocol, refer to
the list of related documents in 1.8, Related documents.

Information in this user's guide is intended for application engineers who install the
servers and clients needed to configure the different components. As a prerequisite, you
should have basic knowledge of client and server architectures in general. Note that the
protocol specific server and client user's guides contain more detailed information and
should be used to complement this manual.
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Document conventions1.4.

The following conventions are used for the presentation of material:
• The words in names of screen elements (for example, the title in the title bar of a

window, the label for a field of a dialog box) are initially capitalized.
• Capital letters are used for the name of a keyboard key if it is labeled on the keyboard.

For example, press the ENTER key.
• Lowercase letters are used for the name of a keyboard key that is not labeled on the

keyboard. For example, the space bar, comma key, and so on.
• Press CTRL+C indicates that you must hold down the CTRL key while pressing

the C key (to copy a selected object in this case).
• Press ESC E C indicates that you press and release each key in sequence (to copy

a selected object in this case).
• The names of push and toggle buttons are boldfaced. For example, click OK.
• The names of menus and menu items are boldfaced. For example, the  File menu.

• The following convention is used for menu operations:  MenuName > Menu-
Item > CascadedMenuItem. For example: select File > New > Type.

• The Start menu name always refers to the Start menu on the Windows taskbar.
• System prompts/messages and user responses/input are shown in the Courier font.

For example, if you enter a value out of range, the following message is displayed:

Entered value is not valid. The value must be 0 to 30.

• You may be told to enter the string MIF349 in a field. The string is shown as follows
in the procedure:

MIF349
• Variables are shown using lowercase letters:

sequence name

Use of symbols1.5.

This publication includes warning, caution, and information icons that point out safety
related conditions or other important information. It also includes tip icons to point out
useful information to the reader. The corresponding icons should be interpreted as follows.

The electrical warning icon indicates the presence of a hazard
which could result in electrical shock.

The warning icon indicates the presence of a hazard which
could result in personal injury.
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The caution icon indicates important information or warning
related to the concept discussed in the text. It might indicate
the presence of a hazard which could result in corruption of
software or damage to equipment or property.

The information icon alerts the reader to relevant facts and
conditions.

The tip icon indicates advice on, for example, how to design
your project or how to use a certain function.

Terminology1.6.

The following is a list of terms associated with the COM600 HMI that you should be
familiar with. The list contains terms that are unique to ABB or have a usage or definition
that is different from standard industry usage.

DescriptionTerm

An abnormal state of a condition.Alarm

An OPC service for providing information about alarms and
events to OPC clients.

Alarms and Events; AE

An OPC service for providing information about process data to
OPC clients.

Data Access; DA

Part of a logical node object representing specific information,
e.g., status or measurement. From an object-oriented point of
view a data object is an instance of a class data object. DOs are
normally used as transaction objects; i.e., they are data struc-
tures.

Data Object; DO

The data set is the content basis for reporting and logging. The
data set contains references to the data and data attribute val-
ues.

Data Set

A physical device that behaves as its own communication node
in the network, e.g. protection relay.

Device

Change of process data or an OPC internal value. Normally, an
event consists of value, quality and timestamp.

Event

A physical IEC 61850 device that behaves as its own commu-
nication node in the IEC 61850 protocol.

Intelligent Electronic Device

Representation of a group of functions. Each function is defined
as a logical node. A physical device consists of one or several
LDs.

Logical Device; LD
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DescriptionTerm

The smallest part of a function that exchanges data. A LN is an
object defined by its data and methods.

Logical Node; LN

A communication protocol developed by Echelon.LON

A proprietary method of ABB on top of the standard LON pro-
tocol.

LON Application Guideline for
substation automation; LAG

Series of standards specifications aiming at open connectivity
in industrial automation and the enterprise systems that support
industry.

OPC

Representation of a connection to the data source within the
OPC server. An OPC item is identified by a string <object
path>:<property name>. Associated with each OPC item are
Value, Quality and Time Stamp.

OPC item

Named data item.Property

The report control block controls the reporting processes for
event data as they occur. The reporting process continues as
long as the communication is available.

Report Control Block

ABB proprietary communication protocol used in substation
automation.

SPA

Protection and/or Control Product supporting the SPA protocol
version 2.5 or earlier.

SPA device

XML-based description language for configurations of electrical
substation IEDs. Defined in IEC 61850 standard.

Substation Configuration Lan-
guage; SCL

Abbreviations1.7.

The following is a list of abbreviations associated with the COM600 HMI that you should
be familiar with. See also 1.6, Terminology.

DescriptionAbbreviation

Alarms and EventsAE

Application Service Data UnitASDU

Buffered Report Control BlockBRCB

Communication Engineering ToolCET

Data AccessDA

Data Message Code DefinitionDMCD

Data ObjectDO

Gateway, component connecting two communication networks togetherGW

Human Machine InterfaceHMI

International Electrotechnical CommissionIEC
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DescriptionAbbreviation

Intelligent Electronic DeviceIED

LON Application Guideline for substation automationLAG

Local Area NetworkLAN

Logical DeviceLD

LonMark interoperable device communicating in LonWorks network. In
this document the term is used for devices that do not support the ABB
LON/LAG communication.

LMK

Logical NodeLN

LON SPA GatewayLSG

Network Control CenterNCC

Network VariableNV

Object Linking and EmbeddingOLE

OLE for Process ControlOPC

Protection & ControlP&C

Request To SendRTS

Substation AutomationSA

Substation Configuration LanguageSCL

Single Line DiagramSLD

Simple Network Time ProtocolSNTP

Simple Object Access ProtocolSOAP

Report Control BlockRCB

Unbuffered Report Control BlockURCB

eXtended Markup LanguageXML

Related documents1.8.

MRS numberName of the manual

1MRS756125COM600 User’s Guide

1MRS756566DNP LAN/WAN Master (OPC)

1MRS756567DNP Serial Master (OPC)

1MRS755496DNP LAN/WAN Slave (OPC)

1MRS755495DNP Serial Slave (OPC)

1MRS755564External OPC Client Access

1MRS755382IEC 60870-5-101 Slave (OPC)
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MRS numberName of the manual

1MRS752278IEC 60870-5-103 Master (OPC)

1MRS755384IEC 60870-5-104 Slave (OPC)

1MRS755321IEC 61850 Master (OPC)

1MRS755284LON-LAG Master (OPC)

1MRS756569MNS iS Connectivity (OPC)

1MRS756126Modbus Serial Master (OPC)

1MRS756445Modbus TCP Master (OPC)

1MRS752275SPA Master (OPC)

1MRS755497SPA Router (OPC)

Document revisions1.9.

HistoryProduct revisionDocument version/date

Document created3.0A/16.10.2006

Document revised3.0B/22.1.2007

Document revised3.0C/8.6.2007

Document revised3.1D/21.12.2007

Document revised3.2E/17.06.2008
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Introduction2.

Product overview2.1.

Human Machine Interface (HMI) is a browser-based user interface that makes it possible
for the operator to access the COM600 computer both locally and remotely through a
built-in web server.

COM605 and COM615 use an embedded operating system and run in a dedicated
industrial computer without moving parts.

The products are configured using a separate engineering PC that is connected via the
local area network (LAN). For more information, refer to COM600 User's Guide.

Predefined user account2.2.

HMI has a predefined user account with administrator rights.

• User name: admin
• Password: adminadmin

When you log in for the first time as an administrator, you have to change the password
before you can proceed using HMI. If you forget the new password, restore the factory
settings with the Management tool in CET. After the factory settings have been restored,
you can only log in with the predefined administrator password mentioned above.
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Configuration3.

About this section3.1.

This section describes the configuration tasks for HMI.

Prerequisites3.2.

Before you start configuring the HMI, you should pay attention to the following:
1. Prepare the communication structure as instructed in the COM600 User's Guide.
2. Make sure that you have the necessary connectivity packages or SCL description

files that can help you in the configuration process.
3. Outline the Single Line Diagram structure you want to create for your system.

Use the Management function to update the COM600 communication configuration at
least once before you start the substation configuration. If you do not update the config-
uration, the statuses of objects in HMI Single Line Diagram can be bad or uncertain.

To fix the statuses of objects in Single Line Diagram:
1. Save the substation configuration.
2. Update the COM600 configuration with the Management function by changing any

property in SLD Editor and by clicking Apply.
3. Update the COM600 configuration again using with the Management function.

Creating substation structure and communication
structure

3.3.

Creating substation and communication structures with SCL
descriptions or connectivity packages

3.3.1.

To create the substation and communication structures with SCL descriptions or con-
nectivity packages:
1. Create Substation and Voltage level objects to the substation structure.
2. Create the OPC Server and communication channel objects to the communication

structure.
3. Create the IED object below the communication channel and use either the connectiv-

ity package or IED SCL description file to automatically populate the structure
below the IED. The substation structure is automatically populated with primary
apparatus objects described in the connectivity package or SCL descriptions. You
may be prompted to give some information to guide the process, for example choose
a voltage level or give a bay name.

4. Repeat step 3 for each IED.
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5. Fine tune the SLD layout (assign colors, specify incoming/outgoing feeders and so
on) by modifying or adding objects. Additionally you might need to create busbar
connections, see 3.3.2,  Creating substation structure manually .

6. Download the configuration to the COM600 computer.

Creating substation structure manually3.3.2.

The following is an overview of creating a substation structure manually. For a more
detailed description, see 3.3.3, Adding Gateway object, 3.3.4, Adding Substation,
3.3.5, Adding voltage level object, 3.3.6, Adding bay object and 3.3.7, Adding busbar
object.

Before you can create a substation structure, you have to create
a communication structure with OPC Server and communica-
tion channel objects, IEDs, Logical Devices, Logical Nodes
and Data objects.

To create the substation structure manually:
1. Create Gateway, Substation and Voltage level objects to the substation structure.
2. Add bays and busbars, and design their layout using the SLD Editor. Connect your

substation structure objects to communication structure (logical nodes) using the
data connection function, see 3.5.1, General about Data connection .

If the configurations of the bays are similar, you can copy the
bay object and the data it contains. This way you do not have
to add each bay separately to the substation structure.

3. Design your voltage level layout by connecting busbars and bays and relocating
them with the SLD Editor. Open the SLD Editor by right-clicking the voltage level
object.

4. Design your substation layout by connecting possible transformer windings between
voltage levels. Relocate voltage levels with the SLD Editor. Open the SLD Editor
by right-clicking the substation.

5. Fine tune SLD settings, for example fonts and colors, see 3.5.2, Settings .

Adding Gateway object3.3.3.

To link the Gateway object to the substation structure:
1. Select the Gateway object in the Communication structure.
2. Copy the Gateway object by selecting Edit > Copy or by right-clicking the object

and selecting Copy.
3. Open the Substation structure.
4. Select the project name and right-click it.
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5. Select Paste Link, see Figure 3.3.3-1.
6. Modify the Gateway properties if necessary.

linkGW.bmp

Figure 3.3.3-1 Linking a Gateway object

The object properties for the Gateway are presented in Table 3.3.3-1.

Table 3.3.3-1 Object properties for Gateway
DescriptionVale or Value range/DefaultProperty/Para-

meter

Basic

True

False

Default: True

Audio Alarm
Browser Enabled

True

False

Default: True

Audio Alarm Local
Enabled

\Opc Server Tree
Delimiter

True

False

Default: True

Watch Dog Enabled

DCOM

Node name for gatewayIP

Adding Substation3.3.4.

After the Gateway object has been successfully added, you can continue building the
object tree by adding substation objects.
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To add a substation object:
1. Select the Gateway object and right-click it.
2. Add a substation object by selecting New > Functional > Substation.
3. Rename the new object. Note that the names of the substation objects have to be

unique.
4. Modify substation properties if necessary.

You can define only one substation per project.

Adding voltage level object3.3.5.

After the substation object has been successfully added, you can continue building the
object tree by adding voltage level objects.

To add a voltage level object:
1. Select the substation object and right-click it.
2. Add a voltage level object by selecting New > Functional > Voltage Level.
3. Rename the new object. Note that the names of the voltage level objects have to be

unique.
4. Modify voltage level properties if necessary.

The object properties for voltage level are presented in Table 3.3.5-1.

Table 3.3.5-1 Object properties for voltage level
DescriptionVale or Value range/DefaultProperty/Para-

meter

Basic

Nominal voltage20Voltage

Adding bay object3.3.6.

After the voltage level object has been successfully added, you can continue building
the object tree by adding bay objects.

To add a bay object:
1. Select the voltage level object and right-click it.
2. Add a bay object by selecting New > Functional > Bay.
3. Rename the new object. Note that the names of the busbar objects have to be unique.
4. Modify bay properties if necessary.
5. Design the bay layout using SLD editor, see 3.4.1, Using the SLD Editor.
6. Use the data connection function, see 3.5.1, General about Data connection.
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Adding busbar object3.3.7.

After the voltage level object has been successfully added, you can continue building
the object tree by adding busbar objects.

To add a busbar object:
1. Select the voltage level object and right-click it.
2. Add a busbar object by selecting New > Functional > BusBar.
3. Rename the new object. Note that the names of the busbar objects have to be unique.
4. Modify busbar properties if necessary.
5. Design the busbar layout using SLD editor, see 3.4.1, Using the SLD Editor.

Single Line Diagram3.4.

Using the SLD Editor3.4.1.

You can open the SLD Editor by selecting substation, voltage level, bus or bay object
and right-clicking them and by selecting SLD Editor from the menu. The higher level
contains the layout of the lower levels.

With the SLD Editor you can add objects to the Single Line Diagram, modify existing
objects, and specify electrical connections. You can also fine-tune the diagram's layout
and add and modify descriptive texts. You can drag and drop symbols needed in the SLD
from the symbol library.

To open the SLD Editor Tool:
1. Click the Substation structure tab.
2. Select the Bay or the Busbar object.
3. Right-click on the Bay or the Busbar object and select SLD Editor.

or
From the main toolbar, select Tools > SLD Editor.

Creating a diagram with the SLD Editor

To create a diagram with the SLD Editor:
1. In the Symbols view, click the tabs to view the different sets of symbols, see Fig-

ure 3.4.1-1.
2. Click on a symbol you want to use and drag it with the mouse to the Single Line

Diagram view.
3. Place Connectivity Nodes between switches and transformers that will be connected.
4. Select the Direct Link tool from the SLD toolbar and link the symbols together by

clicking first the start and then the end point of a connection.
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Symbols can be graphically grouped together by drawing a rectangle border around them
by selecting the Rectangle button. This feature is only a visual aid and does not affect
the functionality of the SLD.

Figure 3.4.1-1 SLD symbols

Bay SLD

To create a bay SLD:
1. Add primary objects (Switchgear objects, measurement transformers and power

transformers).
2. Rename the primary object using the name property in the property grid. This name

will be used in HMI for the object.
3. Add primary Connection objects (e.g. feeders, earth symbols).
4. Add Connectivity Nodes.

• Switchgears are connected to each other with a connectivity node.
• Feeder objects are connected to switchgear objects with a connectivity node.
• Transformer objects are connected to switchgear objects with a connectivity

node.

No connectivity nodes should be added for the connection
between the busbar and the bay switchgears.
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No connectivity nodes should be added between the earth
symbol and the switchgear object (disconnector).

A connectivity node for connecting Power transformer
to another bay should be created in the target bay (not in
the bay where the power transformer is located).

5. Add Via points, if you want the line to follow a certain route.
6. Connect objects

• Activate the Direct Link tool from the tool bar.
• Link two objects together by selecting their link points.
Additionally you can add a Bay Switch indicator, annotations and measurement text
boxes.

Bay_SLD_32.png

Figure 3.4.1-2 The Bay SLD view
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Measurement text box configuration

To be able to configure the Measurement text box, you need
to use the Data Connect function to connect the measurement
logical nodes from the communication structure to the bay.

To configure the Measurement text box:
1. Right-click the object and select Configure Measurement function from the menu.
2. Using the configuration dialog, select the measurements to be shown in HMI.

If the IED does not provide a unit for the measurement, it is
possible to specify the unit here.

Measurement_configuration.jpg

Figure 3.4.1-3 The Measurement Configuration dialog
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Bay Switch Indicator configuration

To be able to configure the Bay Switch Indicator, you need
to use the Data Connect function to connect the logical node
containing the Loc information (LLN0) from the communica-
tion structure to the bay.

To configure the Bay Switch Indicator:
1. Right-click the object and select Configure Bay Switch Indicator from the menu.
2. Using the configuration dialog, select the source for the local remote switch indication

(for example LLN0.Loc.stVal) to be used in HMI.

Bay_Switch_indicator_configuration.jpg

Figure 3.4.1-4 The Bay Switch Indicator configuration dialog

Busbar SLD

To create a busbar SLD:
1. Add Busbar start and end objects (only one start and end point is allowed).
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2. Add a Connectivity Node (one connectivity node is enough to connect all bays to
this busbar).

3. Connect the objects.
• Activate the Direct Link tool from the tool bar.
• Two objects linked together by selecting their link points.

You can adjust the size of busbar in the bay and voltage level views as well as the busbar
view. You can also add annotations.

Bay_SLD_32.png

Figure 3.4.1-5 The Busbar SLD view

Busbar Coloring

Busbar Coloring is automatically configured when the SLD is drawn. Connecting
switchgear objects together specifies their electrical connections, which is used during
runtime to calculate the proper coloring. Settings tool in the substation gateway object
has tab page for the Busbar coloring, where, for example, the used colors can be modified.
The value of the voltage property on the voltage level object is used for the voltage level
based busbar coloring mode.

Voltage level SLD

To create a voltage level SLD:
1. Drag the bays to correct locations in the SLD (name of the selected bay can be seen

in the property grid).
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2. Connect bays to busbars. Select a bay, right-click it and select Connect to a Busbar
from the menu.

3. In the configuration dialog, select the corresponding switchgear and the busbar
object to connect them.

Although the SLD Editor shows the lines between the
bays and the busbar connected to the same point in the
busbar, they will be drawn to separate locations in HMI.

4. If you want to fine tune the SLD Editor layout for the connection lines, you can add
a StopAt object from menu of the line. Move the SoptAt point to the correct location
in the busbar.

You can also add annotations.

Voltage_level_SLD_32.png

Figure 3.4.1-6 The voltage level SLD view

Substation SLD

To create a substation SLD:
1. If you have more than one voltage level object, drag the objects to correct locations

in the SLD.
2. Voltage levels are connected to each other via a power transformer. Select a voltage

level containing the transformer, right-click it and select Connect Winding to a bay
function from the menu.
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3. Using the configuration dialog, you can select winding and the target bay/connectivity
node.

4. Add Station switch indicator (local/remote) Configuration.

To configure the Station Switch Indicator, use the Data Con-
nect function to connect the logical node containing the
information (SPS CDC) from the communication structure to
the substation.

SLD_Editor_Tool_32.png

Figure 3.4.1-7 Substation SLD view

Data connection3.5.

General about Data connection3.5.1.

The Data Connection function is used to connect the substation structure objects to the
communication structure. Process data values based on the communication structure
objects are used to update the symbol states in HMI. It is also used to get object
descriptions based on the substation structure names to the alarm and event lists.
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Any data object that has event class defined in the communic-
ation structure, should be linked to the substation structure to
get the proper description to the alarm and event.

Before you can use the Data connection function, you have to create the communication
structure, see 3.3.1, Creating substation and communication structures with SCL
descriptions or connectivity packages. Then you have to link the symbols together in the
SLD Editor Tool, see 3.4.1, Using the SLD Editor.

To connect the substation structure objects to the communication structure:
1. In the Substation structure select a Substation, Bay or Voltage level object and right-

click it. Select Data Connection to open the Data connection function.
The objects linked together in the Single Line Diagram are presented on the left side
of the Data connection window. The logical nodes that can be attached to the objects
are presented on the right side of the Data connection window.

2. Click on an equipment on the left side of the Data connection window. The logical
nodes are listed in the structure on the right side of the window.

3. Double-click the logical node to attach/detach it to the correct equipment/object.
4. Click Apply to save the changes.

Data_connection.jpg

Figure 3.5.1-1 The Data connection window
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Settings3.5.2.

You can define SLD settings in the Settings dialog. To open the Settings dialog, right-
click the Gateway object and select Settings.

The Settings dialog contains the following tabs:
• Generic: You can define general settings, for example the symbol set (ANSI or

IEC) and element size.
• Alarm Settings: You can define color settings and appearance for the alarms.
• Measurement Status: You can define color settings for different alarm levels.
• Default Colors: You can modify the default colors of devices.
• Fonts: You can modify the font definitions.
• Measurement Precisions: You can adjust the precision settings of the measurements.
• Bus Bar Settings: You can define busbar colors and busbar settings.

Alarm and event handling3.6.

General about alarm and event objects3.6.1.

Alarm and event objects define the types of events and alarms that are generated and the
alarm and event messages displayed in HMI. It is possible to modify existing alarm and
event objects (see 3.6.2, Modifying existing alarm and event objects) and to create new
objects (see 3.6.3, Creating new alarm and event objects).

The communication structure contains the following event groups:
• Process Event Definitions
• Communication Diagnostic Event Definitions
• Common Event Settings
• Scale Definitions
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event_classes.png

Figure 3.6.1-1 Event groups

Modifying existing alarm and event objects3.6.2.

To modify existing alarm and event objects:
1. Select the event class in the communication tree structure.
2. Select the desired event object from the list.
3. Right-click the event object and select Properties.
4. Make the necessary modifications to the event object in the Object Properties

window.

Creating new alarm and event objects3.6.3.

To create new alarm and event objects:
1. Select the event class group in the communication structure and right-click it.
2. Select New > Event Classes.
3. Select the desired event class type from the list. The new object is added to the

communication structure. Rename the object.
4. Right-click the event object and select Properties.
5. Make the necessary modifications to the event object in the Object Properties

window.
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Creating and modifying links between alarm or event objects
and data objects

3.6.4.

You can modify links between alarm or event objects and data objects by creating new
event class objects or by modifying the existing event class objects. You can also delete
and create new links.

Data objects are linked to event classes by selecting the used event class from the prop-
erties of the data object. Depending on the data class, the object may have an event class
property both for indication and control events or only one of them. These properties
define the event classes that will be used with the data object.

Customizing IED parameter settings3.7.

In order to have the parameters of an IED added automatically to the selections list, the
connectivity package for the IED that supports the parameter information should be
installed.

With the Parameter Selection tool of CET, you can select the parameters that are shown
in the Parameter Setting view in HMI. This option helps you to create a user-friendly
view for HMI.

Selecting parameters

To select parameters:
1. Click the Communication tab on the left.
2. Right-click the IED object and select Parameter Filtering Tool. A Parameter Fil-

tering view opens. All the logical nodes the device contains are displayed on the
left side of the Parameter Filtering view.

3. Click on a logical node to view all the possible parameters.
4. Select the check box of the parameters you want to be displayed in the Parameter

Setting view of HMI, see Figure 3.7-1. To select all parameters, click Select. To
clear all parameters, click Deselect.

5. Click Apply to save the selected parameters.
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parameter_selection_tool.bmp

Figure 3.7-1 Parameter Selection Tool

Importing parameters

With this function it is possible to import an existing Parameter Filtering Tool configur-
ation for example from another computer.

Adding new parameters

You can add a new parameter to the Parameter Filtering view.

To add a new parameter:
1. Click Add Parameter in the Parameter Filtering view. The Add Parameter Form

window opens, see Figure 3.7-2.
In the Add Parameter Form window you can fill in the information on the parameter
you want to add or select a suitable option from a drop-down list.

2. After you have added all necessary information, click Apply to add the parameter
to the Parameter Filtering view.
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Add_parameter_form.bmp

Figure 3.7-2 The Add Parameter Form window

If a parameter row has been selected in the Parameter Filtering
view, the Add Parameter button opens the selected parameter.
The changes will be made to the selected parameter.

Exporting parameters

You can export the information of the selected parameters to an Excel file.

To export the parameter selection:
1. Select the parameters you want to export.
2. Click Excel Export. The Excel Export File window opens.
3. Select the folder where you want to export the file and click Save.

Disturbance data upload3.8.

The basic support for the disturbance data upload (data upload and conversion to
COMTRADE format) will be implemented to each OPC Server. Protocol and device
specific differences will be hidden from the OPC client. The files will be stored tempor-
arily to the COM600 computer, where they can be transferred further using for example
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ftp. COM615 will have a possibility to activate the disturbance data upload from the
IED and to receive the file into the computer where HMI is run.

If the IED and the OPC server used for communication support disturbance data upload,
the properties for configuring the function can be found from the corresponding OPC
server user's manual, see 1.8, Related documents.

Project-specific localization3.9.

With CET you can modify the project specific texts that are displayed in HMI. Static
HMI texts, for example menus and headers, can be translated by the local ABB. For
more information on localization, contact your local ABB representative.

To localize objects in the substation structure or communication tree:
1. Select the object you want to modify.
2. Right-click the object and select Rename.
3. Modify the name of the object.

To localize object properties:
1. Select the object you want to modify in the Substation or Communication structure.
2. Right-click the object and select Properties. The Object properties window opens.
3. Modify the text properties of the object.
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Appendix 1

Single Line Diagram symbols

Table A1-1 Single Line Diagram symbols
RemarksIEC represent-

ation
ANSI repres-
entation

Description

Annotation

Alarm indicator in a branch of
the substation. Use at any level
in the structure to indicate
alarms generally, or a specific
alarm. The indicator is not vis-
ible in the web view when there
are no active alarms.

Alarm Indicator

Binary indicator (on/off, auto-
matic/manual, X/not-X, etc.). It
can also be used to send a
command.

Two State Switch

Hyperlink to external informa-
tion source, such as a web
page or a local file on COM600.

Files should be stored under
C:\Program Files\COM610 GW
SW\WebHMI\UserDocs\. The
total size of the files should not
exceed 100 MB. Link syntax for
local files is: http://<COM600
IP address>/HMI/User-
Docs/<filename>

Launch Web Page

Use to send a single command
to one target.

Push Button

Use to launch an application
external to COM600

Application Launch

Measurement Text Box

ViaPoint

Connectivity Node
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RemarksIEC represent-
ation

ANSI repres-
entation

Description

Circuit breaker – Intermediate
position

Circuit breaker – Open position

Circuit breaker – Closed posi-
tion

Circuit breaker – Bad (faulty)
position

Disconnector – Intermediate
position

Disconnector – Open position

Disconnector – Closed position

Disconnector – Bad (faulty)
position

Truck – Intermediate position

Truck – Open position

Truck – Closed position

Truck – Bad (faulty) position

Use IEC rep-
resentation

Load breaker – Intermediate
position

Use IEC rep-
resentation

Load breaker – Open position

Use IEC rep-
resentation

Load breaker – Closed position

Use IEC rep-
resentation

Load breaker – Bad (faulty)
position

Use IEC rep-
resentation

Contactor – Intermediate posi-
tion

Use IEC rep-
resentation

Contactor – Open position
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RemarksIEC represent-
ation

ANSI repres-
entation

Description

Use IEC rep-
resentation

Contactor – Closed position

Use IEC rep-
resentation

Contactor – Bad (faulty) posi-
tion

Primary winding: on top. Sec-
ondary winding: below. All
composing elements exist as
individual symbols.

Power Transformer with two
Windings and no Tap Changer

Primary winding: on top. Sec-
ondary winding: below. All
composing elements exist as
individual symbols.

Power Transformer with two
Windings and Tap Changer

Primary winding: on top. Sec-
ondary winding: below left.
Tertiary winding: below right.
All composing elements exist
as individual symbols.

Power Transformer with three
Windings and no Tap Changer

Primary winding: on top. Sec-
ondary winding: below left.
Tertiary winding: below right.
All composing elements exist
as individual symbols.

Power Transformer with three
Windings and Tap Changer

Voltage Transformer (measure-
ment)

Current Transformer (measure-
ment)

Capacitor

Reactor

Generator

Motor

Use ANSI rep-
resentation

In-feeder

Use ANSI rep-
resentation

Out-feeder

Use ANSI rep-
resentation

Earth symbol
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RemarksIEC represent-
ation

ANSI repres-
entation

Description

Use ANSI rep-
resentation

Bay Switch Indicator

Use ANSI rep-
resentation

Station Switch Indicator
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Appendix 2

CET Toolbar

DescriptionSymbol

Displays the Substation and Communication Structure in the Project Explorer window.

Displays the Object Properties window.

Displays the messages in the Output window.

Displays a list of the object types.

Selects an object in the SLD Editor window.

Enables navigation of the SLD Editor window using a mouse.

Displays a grid view in the SLD Editor window.

Zooms in/out the SLD Editor window.

Opens the direct link tool.

Rotates the selected objects left in the SLD Editor window.

Rotates the selected objects right in the SLD Editor window.

Used to draw rectangles around grouped objects
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Appendix 3

Logical nodes and primary objects

Logical nodes can be connected to primary objects according to the following table. If
no specific function is written in the Comment column, the connection will be used for
displaying the substation structure based on identification for the events and alarms.

Table A3-1 Locigal node classes and primary objects
CommentMandatoryLN ClassPrimary object

Substation

Loc data used for sta-
tion/remote switch
state

LLN0

SIMG

CALH

M*

G*

Q*

Voltage Level

SIMG

CALH

M*

G*

Q*

Bay

Loc data used for bay
local/remote switch
state

LLN0

LPHD

SIMG

SARC

SIML

SPDC

CALH

M*

P*

R*
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CommentMandatoryLN ClassPrimary object

G*

T*

Q*

Circuit Breaker (CBR)

XCBR

Pos data used for
switch device position
and control.

MandatoryCSWI

RREC

Rel data used for syn-
chronism-check status
in control dialogs.

RSYN

EnaOpn and EnaCls
data used for interlock-
ing status in control
dialogs.

CILO

PTRC

SIML

CALH

G*

Disconnector (DIS)

XSWI

Pos data used for
switch device position
and control.

MandatoryCSWI

RREC

Rel data used for syn-
chronism-check status
in control dialogs.

RSYN

EnaOpn and EnaCls
data used for interlock-
ing status in control
dialogs.

CILO

PTRC

SIML

CALH

G*

Voltage Transformer
(VTR)

TVTR
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CommentMandatoryLN ClassPrimary object

CALH

G*

Current Transformer
(CTR)

TCTR

SARC

SPDC

CALH

G*

Q*

Power Overhead Line
(LIN)

ZLIN

CALH

G*

Rotating Reactive
Component (RRC)

ZRRC

CALH

G

Surge Arrestor (SAR)

ZSAR

CALH

G

Thyristor controlled
frequency converter
(TCF)

ZTCF

CALH

G

Thyristor controlled
reactive component
(TCR)

ZTCR

CALH

G*
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CommentMandatoryLN ClassPrimary object

Power Transformer
Winding (PTW)

G*

Incoming Feeder Line
(IFL)

CALH

G*

Q*
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